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LESSON 1 -  
USING MAIL MERGE  

WORKING WITH MAIL MERGE 

 Discussion 
The Mail Merge Wizard provides a quick and easy way to create merged documents such as form 
letters. Mail Merge utilizes two types of documents, a main document and a data source. The main 
document (often a form letter) contains the information common to each letter or form. The data 
source contains the variable information (such as names and addresses). You only have to create the 
main document once; when you merge the variable information into the main document, one merged 
document is created for each record in data source, with the variable information inserted into the 
corresponding merge fields. 
 
In addition to form letters, you can use Mail Merge to print mailing labels and envelopes or create a 
directory. Mail Merge can produce documents in many formats, including printed letters, files stored 
to disk to be printed at a later time, fax documents, and electronic mail messages. 
 
Mail Merge involves the following six basic steps: 

 
1. Selecting the document type. 
2. Creating or selecting the main document. 
3. Creating or opening the data source. 
4. Inserting the merge fields into the main document. 
5. Previewing the merged document. 
6. Completing the merge. 

 
Mail Merge involves opening the Mail Merge Wizard and using the steps outlined in the Mail Merge 
task pane to complete the mail merge. The Mail Merge task pane provides the most guidance when 
merging documents. 
 
You can also use buttons available on the Mail Merge toolbar to merge documents. These buttons are 
arranged in order of usage, from left to right. The buttons on the Mail Merge toolbar are context-
sensitive and change depending upon where you are in the Mail Merge Wizard. 
 



Lesson 1 -  Using Mail Merge 

Page 2 University Information Technologies 
 

STARTING THE MAIL MERGE WIZARD 

 Discussion 
The first step in performing a mail merge is to open the Mail Merge Wizard. The Mail Merge Wizard 
uses the Mail Merge task pane to guide you in creating, opening, and modifying both the main 
document and the data source. The Mail Merge task pane provides instructions for each step in the 
process. In addition, you can go back to any previous step to review or modify the mail merge. 
 

 Procedures 

1. Create or open the form letter you want to use as the main document. 

2. Select the Tools menu. 

3. Point to the Letters and Mailings command. 

4. Select the Mail Merge Wizard command. 

 

IDENTIFYING THE MAIN DOCUMENT 

 Discussion 
Before you can perform a mail merge, you must identify the type of main document you want to use. 
The main document contains the information common to all merged documents. 
 
The following types of documents are available in Mail Merge: 

 
Document Type Definition 
Letters Creates standard form letters 
E-mail messages Creates e-mail messages 
Envelopes Creates envelopes 
Labels Creates mailing and other types of labels 
Directory Creates a single catalog list or printed list of addresses 

 
After you have identified the type of main document, the next step is choosing whether to use the 
current document or to create a new one. 
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 Procedures 

1. Open the document you want to use as a form letter. If you don’t have the letter written yet, begin 
with a blank document. 

2. Open the Mail Merge task pane, if necessary. 

3. Under Select document type, select the desired document type option. 

4. Under Step 1 of 6, select the Next: Starting document link. 

5. Under Select starting document, select the Use the current document option. 

 

CREATING A DATA SOURCE 

 Discussion 
The next Mail Merge step is to create or identify the data source. The data source contains the variable 
information that will be inserted into the merge fields in the main document. A data source can be a 
Word document, a spreadsheet (such as an Excel workbook), a database (such as an Access database), 
or an Outlook contact list. 
 
It is helpful to think of the data source as an index card file, with each index card containing one 
record (i.e., all the information about one person, such as name, address, telephone number, etc.). If 
you create a data source in Word, it is saved as an Access database (with an .mdb extension) in the 
My Data Sources folder. 
 
Before you create a data source, you must first define what information you want to store in each 
record. Each individual piece of information in a record is called a field. For example, first name, last 
name, street, city, etc., are all fields. 
 

  

 
If your data source already exists, see the section entitled “Using an Existing Data Source” 
on page 7. 

  
 

 Procedures 
 

 

1. Begin a mail merge and complete steps 1 and 2. 

2. Under Step 2 of 6, select the Next: Select recipients link. 

3. Under Select recipients, select the Type a new list option. 

4. Select the Create link. 
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ADDING FIELDS TO A DATA SOURCE 

 Discussion 
When creating a data source, Word provides a variety of predefined fields. Each field is identified by a 
label called a field name. You can select which fields you want to include in your data source. You 
should fill in as much information as possible; you can select which fields you want to include in the 
mail merge itself at a later time. 
 
Your data source can be customized by adding, deleting, or renaming fields. Word also allows you to 
arrange the order of the fields. 
 

  

 
A new field is always entered below the current field in the Customize Address List dialog 
box. 

  

 
Field names can contain spaces (e.g., Zip Code). 

  
 

 Procedures 

1. Begin a mail merge and create a new data source in step 3.  

2. Select Customize in the New Address List dialog box. 

3. Select Add. 

4. Type the desired field name in the Type a name for your field box. 

5. Select OK. 

 

REMOVING FIELDS FROM A DATA SOURCE 

 Discussion 
When you are creating a data source, you can probably use many of the default fields provided by 
Word. You can and should, however, remove fields you do not plan on using in the mail merge. 
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 Procedures 

1. Begin a mail merge, create a new data source in step 3, and open the Customize Address List 
dialog box. 

2. Select the field you want to remove from the Field Names list box. 

3. Select Delete. 

4. Select Yes. 

 

REARRANGING FIELDS IN A DATA SOURCE 

 Discussion 
After you have added and removed fields, you should arrange them in the appropriate order for 
entering data. For example, if you want to enter the last name into a record before entering the first 
name, you should move the Last Name field above the First Name field. 
 

  

 
The order in which you enter data does not affect the order of the data in the merged 
document. 

  
 

 Procedures 

1. Begin a mail merge, create a new data source in step 3, and open the Customize Address List 
dialog box. 

2. Select the field you want to move in the Field Names list box. 

3. Select Move Up or Move Down as desired. 

 

SAVING A DATA SOURCE 

 Discussion 
After you have created the desired fields, it is a good idea to save your data source before you begin to 
enter records. When you save the data source, it is earmarked as a Mail Merge data source. 
 

  

 
You can open the data source in Microsoft Access to make changes to it. 
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By default, data source files are saved to the My Data Source folder in the My Documents 
folder. 

  
 

 Procedures 

1. Begin a mail merge, create a new data source in step 3, and open the Customize Address List 
dialog box. 

2. Select OK. 

3. Select Close. 

4. Type the desired file name in the File name box. 

5. Select Save. 

 

ENTERING RECORDS INTO A DATA SOURCE 

 Discussion 
After you have saved the data source in a mail merge, you are ready to enter the variable information 
into each individual record. 
 
You cannot enter multiple lines in a data source field. 
 

  

 
You can use the [Enter] or [Tab] key to move to the next field in the address list dialog box 
and the [Shift+Tab] key combination to move to the previous field. 

  

 
When you press the [Enter] key twice at the end of a record in the address list dialog box, 
the next record appears. You can also use the New Entry button to create a new data record. 

  
 

 Procedures 

1. Begin a mail merge and create and save a new data source in step 3. 

2. In the Mail Merge Recipients dialog box, select Edit. 

3. Type the desired information into the first field. 

4. Press [Enter]. 
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5. Enter information as desired into the remaining data fields. 

6. After completing the first record, select New Entry to add a second record. 

7. Enter information into additional records as desired. 

8. When you have entered all the desired records, select Close. 

9. Select OK. 

 
 

USING AN EXISTING DATA SOURCE 

 Discussion 
Often times, the data that you will use for your mail merge will come from an external data source, 
such as Excel, Oracle Discoverer, Banner, or Access. If this is the case, in Step 3 of 6 of the Mail 
Merge Wizard, you will need to select Use and existing list instead of Type a new list. Once you 
have selected Use an existing list, you must Browse for that data source and select the data file from a 
list. 
 
Word 2003 will import just about any type of data file into the Mail Merge Wizard, including Excel 
spreadsheets (even those exported from Oracle Discoverer), comma-delimited text files, and Access 
tables and queries, to name a few.  
 

  

 
Before using an Excel spreadsheet or data file exported from Oracle Discoverer, it is a good 
idea to open the file in Excel to make sure that the first row contains the field names and that 
there are not empty rows at the top of the file. 

  

 
When browsing for your existing data source, if you don’t see your file, you may need to 
change the “Files of Type” box to “All Files (*.*).” 

  

 
When you browse for an existing data source, or list, Word first looks in the “My Data 
Sources” subfolder of your My Documents folder. You may need to change the “Look in” to 
your My Documents folder or the folder or drive that the data file is stored in. 

  
 

 Procedures 

1. Begin a mail merge and complete steps 1 and 2. 

2. Under Step 2 of 6, select the Next: Select recipients link. 

3. Under Select recipients, select the Use an existing list option. 

4. Select the Browse link. 
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5.  When the Select Data Source window opens, select your existing data file. 

6. If you do not see your data file, you may need to change the Files of Type to All Files and the 
Look in window to the drive/folder where the file is located. 

7. If the data file is in Excel format, you will be asked which worksheet you want to use. 

8. If the data file is in txt or csv format, you will be asked to Select the encoding to make your file 
readable. Select the Windows (Default) and click OK. 

9. Your data file will be imported into the Mail Merge Recipients window and you are ready to 
proceed to step 4. 

 
 

SETTING VIEW OPTIONS FOR MERGING 

 Discussion 
Before you begin inserting merge fields into the main document, you should set two specific View 
options in the Options dialog box. 
 
You should deselect the Field codes option so that the field codes are hidden. In this way, you cannot 
inadvertently change a field name and the chance of error in the Mail Merge process is reduced. In 
addition, the field codes must be hidden in order to view the merged documents properly. 
 
It is also a good idea to set the Field shading list option to Always. When merge fields are shaded in 
gray, they are easy to recognize. 
 

 Procedures 

1. Select the Tools menu. 

2. Select the Options command. 

3. Select the View tab. 

4. Under Show, deselect the Field codes option. 

5. Select the Field shading list. 

6. Select Always. 

7. Select OK. 
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INSERTING MERGE FIELDS INTO A DOCUMENT 

 Discussion 
The next step in the Mail Merge process is to insert merge fields into the main document. 
 
Merge fields are inserted at the insertion point. When inserted, a merge field is enclosed in chevrons 
(e.g., <<First Name>>); the merge field will be shaded if the Always option on the View page in the 
Options dialog box has been selected. 
 
Clicking the More items... link in the Mail Merge Step 4 of 6 task pane opens the Insert Merge Field 
dialog box. This dialog box is not a modeless dialog box; therefore, after you have inserted a merge 
field, you must close the dialog box to insert another merge field in a different document location. 
Another method is to insert all the fields at the top of the document first, and then move them to the 
desired position. 
 
In addition to inserting the merge field, you must include all necessary spacing and punctuation, both 
before and after the inserted merge field. For example, if you are inserting the City, State, and ZIP 
Code fields in a return address, you must type a comma and a space after the City field and a space 
after the State field if that is how you want the address to appear. 
 
Word also provides groupings for common main document items, including addresses, greeting lines, 
and postal bar codes. These groupings include all necessary spacing and punctuation. You can easily 
insert a grouped merge field by clicking the corresponding link in the Mail Merge task pane. When 
you click a grouped item link, a dialog box opens, from which you can select the desired formats and 
options. 
 

  

  IMPORTANT NOTE: You can reposition the insertion point and add 
punctuation while inserting fields if you add the Insert Merge Field menu 
(which displays fields in a drop-down list) to the Mail Merge toolbar. You can 
add this menu by clicking the Toolbar Options button at the end of the Mail 
Merge toolbar, pointing to the Add or Remove Buttons command, pointing to 
the Mail Merge command, and finally selecting the Insert Merge Field 
command at the bottom of the list. Then click away from the list. To save this 
change, hold Shift and click File on the menubar. Select Save All. If promoted, 
give your document a name and click Save. 

  

 
You can detach a main document from its data source by clicking the Main document setup 
button on the Mail Merge toolbar and then selecting the Normal Word document option. 

  

 
Word also provides buttons on the Mail Merge toolbar for inserting an address block or a 
greeting line, as well as the Insert Merge Fields button, which opens the Insert Merge 
Fields dialog box. 
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 Procedures 

1. Begin a mail merge and complete steps 1 through 3. 

2. Under Step 3 of 6, select the Next: Write your letter link. 

3. Position the insertion point where you want to insert the first merge field. 

4. Under Write your letter, position the insertion point where you want to insert a grouped merge 
field and then select the desired grouped item link in the Mail Merge task pane, such as the 
Address Block or Greeting Line.    

OR 
5. Select the More items button and insert the mail merge fields one at a time, in the order that you 

want them to appear in the document. If you want to add punctuation and spacing, or if you want 
to move further down in the letter to insert additional items, you must close the Insert Merge 
Field window to do so. You can add punctuation and spacing at the end, if you’d like. 

See the IMPORTANT NOTE on the previous page for help in making this process easier. 

6. When all of your fields are entered into the letter and your letter is written, you are ready to move 
on to step 5. 

 

PREVIEWING MERGED DATA 

 Discussion 
You can preview the main document with the merged data before you actually perform the mail 
merge. 
 
Previewing the merged document is a good idea; you can use the preview to check for formatting and 
spelling errors. 
 
If you find an error in the main document, you should correct it. If you find an error in a data record, 
you can correct it in the merged document, but you should also correct it in the data source if you plan 
to use it for another merge. 
 

  

 
You can also use the Next Record or Previous Record buttons on the Mail Merge toolbar 
to preview merged records. 

  
 

 Procedures 

1. Begin a mail merge and proceed to step 4. 

2. Under Step 4 of 6, select the Next: Preview your letters link. 
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3. Click the forward arrow  in the task pane as desired to preview the next merged records. 

4. Click the back arrow  in the task pane as desired to preview the previous records. 

 

MERGING TO A NEW DOCUMENT 

 Discussion 
After you have previewed the merged records, you can edit the main document or the recipient list as 
needed, or you can complete the merge. Editing the main document before you merge will affect all 
merged letters; editing a data source record permanently changes the record. 
 
When you complete a merge, you can merge letters directly to the printer, or you can send them to a 
new document. Selecting the Edit individual letters link in the Mail Merge Step 6 of 6 task pane 
automatically sends the merged letters to a new document so that you can make changes to individual 
letters. Changes made to individual letters in the merged document will not be saved back to the main 
document or to the data source. Once the changes have been made, you can save the merged 
document, or send the letters to the printer. 
 
When you select the Edit individual letters link, you can also choose which data records you want to 
merge; all of them or only selected ones. 
 

  

 
You can exclude a record from a merge by deselecting the check box to its left in the Mail 
Merge Recipients dialog box. 

  

 
You can also use the Merge to New Document and Merge to Printer buttons on the Mail 
Merge toolbar to complete a merge. 

  

 
You can detach a main document from its data source by clicking the Main document setup 
button on the Mail Merge toolbar and then selecting the Normal Word document option. 

  
 

 Procedures 

1. Begin a mail merge and proceed to step 5. 

2. Under Step 5 of 6, select the Next: Complete the merge link. 

3. Select the Edit individual letters link. 

4. Select the records you want to merge. 

5. Select OK. 
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SORTING RECORDS TO BE MERGED 

 Discussion 
You can sort a data source by any field simply by clicking the corresponding column heading in the 
Mail Merge Recipients dialog box. For example, you may want to sort records in alphabetical order by 
the Last Name field or in chronological order by the Birth Date field. Clicking the column heading 
once sorts the records in ascending order; clicking it a second time changes the sort to descending 
order. 
 
To sort on up to three fields, you can use the (Advanced) option, available from the drop-down list in 
the column heading of any field, to open the Filter and Sort dialog box. For example, if you have 
several people in a data source named Smith, you can sort the records first by the Last Name field and 
then by the First Name field. 
 
The data source can also be filtered to display only specific records. The drop-down list in any column 
heading displays all the values for that field, as well as several filter options. For instance, you can 
filter the records to merge only those people from New Jersey by selecting NJ from the State field. 
 
You can also select one of the filter options available on any column heading drop-down list. The 
(Blanks) option displays all the records in which the corresponding field is blank. The (Nonblanks) 
option displays all records in which the corresponding field contains any information at all. The (All) 
option displays all records. The (Advanced) option opens the Filter and Sort dialog box, in which you 
can create any number of filters. 
 

  

 
The Filter and Sort dialog box sorts only those records in which the check box is selected in 
the Mail Merge Recipients dialog box. 

  

 
If the data source you want to sort or filter is not open, you can use the Open Data Source 
button on the Mail Merge toolbar to locate and open it. 

  
 

  

 
When merging records, any existing filters and sorts in the Filter and Sort dialog box are 
applied. To remove existing filters or sorts, select the Clear All button on the appropriate 
page. 

  
 

 Procedures 

1. Begin a mail merge, create or select a data source, and insert the merge fields into the main 
document, if necessary. 

2. Click the Mail Merge Recipients button  on the Mail Merge toolbar. 
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3. Click the column heading of the field by which you want to sort. 

4. Click the arrow on the column heading of the field you want to sort. 

5. Select (Advanced...). 

6. Select the Sort Records tab. 

7. Select the Sort by list. 

8. Select the field by which you want to sort. 

9. Select the desired sort order. 

10. To sort by additional fields, select one or both Then by lists and the desired fields and sort orders. 

11. Select OK to close the Filter and Sort dialog box. 

12. Select OK to close the Mail Merge Recipients dialog box. 

 

MERGING TO THE PRINTER 

 Discussion 
Once you have reviewed the merged documents, you can merge them directly to the printer. This 
option allows you to easily print merged documents. 
 

  

 
You can also click the Merge to Printer button on the Mail Merge toolbar to send the 
merged documents to the printer. 

  

 
You can detach a main document from its data source by clicking the Main document setup 
button on the Mail Merge toolbar and then selecting the Normal Word document option. 

  
 

 Procedures 

1. Begin a mail merge and proceed to step 6. 

2. Under Merge, select the Print link. 

3. Select the records you want to merge. 

4. Select OK. 

5. Select OK. 

 



 

 

LESSON 2 -  
MERGING MAILING LABELS, ENVELOPES & DIRECTORIES  

USING MAILING LABELS & ENVELOPES 

 Discussion 
You can use Mail Merge to create mailing labels and envelopes. Since you do not have to use all the 
fields in a data source, you can use the same data source for both form letters and mailing 
labels/envelopes; it is not necessary to create separate data sources for each. 
 
You create labels using the following six steps: 

 
1. Identify the main document. 
2. Set up the main document. 
3. Create or identify the data source. 
4. Insert merge fields into the main document. 
5. Preview the merged labels. 
6. Perform the merge. 

 
To create labels, you must select the Labels option in the Mail Merge task pane for the main 
document. To create envelopes, you must select the Envelopes option in the Mail Merge task pane for 
the main document. 
 
 

CREATING MAILING LABELS/ENVELOPES 

 Discussion 
The first step in creating mailing labels and envelopes is to create or open the main document. After 
the main document has been identified, you can select which type of labels/envelopes you want to 
create. Word offers many standard label/envelope sizes. 
 

 Procedures 

1. Create a new, blank document, if necessary. 

2. Select the Tools menu. 
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3. Select the Letters and Mailings command. 

4. Select the Mail Merge Wizard command. 

5. Under Select document type, select the Labels or Envelopes option. 

 

SELECTING LABEL/ ENVELOPE OPTIONS 

 Discussion 
After you have decided to create labels or envelopes, you can set up the main document. To set up the 
main document, you must specify which type of labels/envelopes you want to create and what printer 
you plan on using. 
 

 Procedures 

1. Begin a mail merge and select the Labels or Envelopes option in step 1. 

2. Under Step 1 of 6, select the Next: Starting document link. 

3. Under Select starting document, select the Change document layout option. 

4. Under Change document layout, select the Label options or Envelope 
Options link. 

5. Select the Label or Envelope type that you are using. 

6. If you are creating labels, refer to the label number on the outside of your box 
of labels. 

7. If you are creating envelopes, select the envelope size. You can also change the 
font and location of the delivery and return addresses. 

8. Click OK. 

 
 

ATTACHING A DATA SOURCE 

 Discussion 
Once you have created the main document for mailing labels/envelopes, you must create or identify 
the data source. The data source contains the variable information to be inserted into the labels/ 
envelopes (such as names and addresses). You can either open an existing data source or create a new 
one. 
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 Procedures 

1. Begin a mail merge and proceed to step 2. 

2. Under Step 2 of 6, select the Next: Select recipients link. 

3. Under Select recipients, select the Use an existing list option. 

4. Under Use an existing list, select the Browse link. 

5. Select the Look in list. 

6. Select the drive or folder where the data source is stored and select 
the desired data source. 

7. Select Open and then OK. 

 

INSERTING LABEL/ENVELOPE MERGE FIELDS 

 Discussion 
Label/envelope merge fields are inserted directly into the main document. You set up the first label or 
envelope as desired, making sure to include all the necessary punctuation and spacing. For example, if 
you insert the Title and LastName fields on the first line, you should include a space between the two 
merge fields. 
 
For labels, after the first label has been set up, then you use the Update all labels button to copy the 
merge fields to the rest of the labels. 
 
For envelopes, you do not have an update button. Simply click on the next step in the Mail Merge 
Wizard to preview your envelopes. 
 

 Procedures 

1. Begin a mail merge and proceed to step 3. 

2. Under Step 3 of 6, select the Next: Arrange your labels or Arrange your envelope 
link. 

3. Position the insertion point in the first label, if necessary. For envelopes, position the 
insertion point in the envelope address area. 

4. To insert individual fields, select the More items link under Arrange your labels or 
Arrange your envelope. 

5. Select the field you want to insert. Select Insert. 

6. Insert additional merge fields as desired. 
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7. Select Close. 

8. Insert punctuation and spacing as needed. 

9. To insert an address block, select the Address block link under Arrange your labels. 

10. Select or deselect options as desired. 

11. Select OK. 

12. For labels, select Update all labels. 

13. For envelopes, click Next: Preview Your Envelopes at the bottom of the Mail Merge 
task pane. 

 

MERGING LABELS TO A NEW DOCUMENT 

 Discussion 
Once you have set up the main document and selected the data source, you are ready to perform the 
merge. 
 
You should view your labels before printing so that you can make any necessary changes. If you find 
typographic errors, you can correct them in the merged document, but you must also correct them in 
the data source if you intend to use it again. 
 
After you have completed the merge, you can print or edit the merged labels as desired. 
 

 Procedures 

1. Begin a mail merge and proceed to step 4. 

2. Under Step 4 of 6, select the Next: Preview your labels or Next: Preview your labels link. 

3. Under Step 5 of 6, select the Next: Complete the merge link. 

4. Print or edit the merged labels or envelopes, as desired. 

 

CREATING A DIRECTORY 

 Discussion 
In addition to form letters, mailing labels, and envelopes, you can create directories, catalogs, and 
mailing lists by creating a Mail Merge directory. Unlike a form letter, which merges only one record 



Lesson 2  Merging Mailing Labels and Directories 

Page 18 University Information Technologies 
 

per page, a directory merges multiple records to the same page. The Directory feature is useful for 
creating any type of list or filling in tables. 
 
The directory main document should only include the desired merge fields and information that you 
want repeated for each record. If you create the following directory main document, the text Name 
and Region will appear to the left of each merged record. To separate the records, you should include 
at least one or two blank lines after the last merge field. 
 

Name: <<Customer Name>> 
Region: <<Region>> 

 
Directory main documents can be used to merge data into a table. The main document table should 
only be a single row, but it can contain multiple columns. You can enter multiple merge fields into 
each cell. 

 
<<First>> 
<<Last>> 

<<Department>> <<Phone>> 

 
Table column headings and additional text can be added after the table has been merged. 
 

  

 
You can format the directory main document to prevent column or page breaks from 
splitting records. To keep table rows together, deselect the Allow row to break across 
pages option on the Row page in the Table Properties dialog box. To keep paragraphs 
together, select the Keep lines together and Keep with next options on the Line and Page 
Breaks page in the Paragraphs dialog box. 

  
 

 Procedures 

1. Select the Tools menu. 

2. Select the Letters and Mailings command. 

3. Select the Mail Merge Wizard command. 

4. Under Select document type, select the Directory option. 

5. Under Step 1 of 6, select the Next: Starting document link. 

6. Under Select starting document, select the desired option. 
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